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Abstract 

In this document I will implement a multi-operation Web Service that will allow patient 
information to be upserted into a database table and will return all patient details for a 
patient whose Facility+Local ID are specified in the request. This service will be used to 
populate the patient table and to implement patient lookup portlets, discussed in other 
walkthroughs in this series. This is a basic Patient Service that hides the specifics of 
interaction with the patient data store form applications that need to interact with it, by 
providing a defined interface and web service-based implementation. Thus the data store 
may change but the service consumers need not. We use Database BC (select, insert, 
update, null values), SOAP/HTTP BC and BPEL SE. 

Introduction 

In some views SOA is represented as a series of 4 layers: Presentation Layer (SOA 1), 
Business Process Layer (SOA 2), Business Service Layer (SOA 3) and Technical Layer 
(SOA 4). Typically each layer higher up in the hierarchy consumes services exposed by 
the layer under it. So the Presentation Layer would consume services provided by the 
Business Process or Business Service Layers. Service interfaces are described using Web 
Services Description Language (WSDL), sheltering service consumers from details of 
service implementation. Web Services are seen as the technical means to implement the 
decoupled functional layers in a SOA development. Decoupling allows implementations 
of business functionality at different layers to be swapped in and out without disturbing 
other layers in the stack.  

In this document I will implement a multi-operation Web Service that will allow patient 
information to be upserted into a database table and will return all patient details for a 
patient whose Facility+Local ID are specified in the request. This service will be used to 
populate the patient table and to implement patient lookup portlets, discussed in other 
writeups in this series. This is a basic Patient Service that hides the specifics of interaction 
with the patient data store form applications that need to interact with it, by providing a 
defined interface and web service-based implementation. Thus the data store may change 
but the service consumers need not. We use the Database BC with select, insert and 
update operations and Database BC with SQL File-based parameterized SQL prepared 
statement. We handle null value insertion on missing data. We also use the SOAP/HTTP 
BC and the BPEL SE. 

The business idea is that patients are looked after in various healthcare facilities. 
Information about patients is stored in a relational database. This information must be 
inserted, for new patients, and updated, for existing patients, as required. Frequently 
applications need to search for a patient and display details to human operators. To shelter 



application developers from the details of the data store the upsert functionality and 
patient details lookup functionality will be made available as a multi-operation web 
service.  

Pre-requisites 

It is assumed that a GlassFish ESB v2.1 installation is available - see [1] for download 
and installation link. 

It is assumed that the MySQL environment, discussed in [2], is present, including 
existence of the pblog MySQL database and user. In effect [2] is a pre-requisite for the 
work done here, as [3] is a pre-requisite for [2]. 

My development environment, for his document, is Windows XP SP2. If you are using a 
different environment you will need to adjust file system paths to suit your system. 

Creating the Patient Table (ui_pid_patient) 

Patient details will reside in a table in a relational database. Before the service can get 
access to that data we need to: 

1. create the database tables and views 
2. populate database tables 
3. verify that we have a NetBeans connection to the database  
4. verify that we have a runtime connection pool at the GlassFish App 

Server 
5. verify that we have a JNDI Reference to the connection pool 

 
If you don’t have the MySQL database installed you can obtain and install it following 
instructions in [3]. 
 
The following text walks through the process of preparing data and verifying connection 
pools for this walkthrough, a step at a time, assuming you have worked through [2] so the 
pblog database and user exist. 
 
Start mysql command line client as the pblog user and execute the following commands 
to create the ui_pid_patient table, which will contain patient data: 

use pblog; 
 
SET FOREIGN_KEY_CHECKS = 0; 
DROP TABLE IF EXISTS `pblog`.`ui_pid_patient`; 
CREATE TABLE `pblog`.`ui_pid_patient` ( 
  `facility` VARCHAR(5) BINARY NULL, 
  `local_id` VARCHAR(25) BINARY NULL, 
  `last_name` VARCHAR(30) BINARY NULL, 
  `first_name` VARCHAR(30) BINARY NULL, 
  `middle_initial` VARCHAR(1) BINARY NULL, 
  `suffix` VARCHAR(5) BINARY NULL, 
  `title` VARCHAR(5) BINARY NULL, 
  `addr1` VARCHAR(30) BINARY NULL, 
  `city` VARCHAR(30) BINARY NULL, 
  `state` VARCHAR(10) BINARY NULL, 
  `post_code` VARCHAR(7) BINARY NULL, 
  `country` VARCHAR(20) BINARY NULL, 
  `dob` VARCHAR(10) BINARY NULL, 
  `sex` VARCHAR(5) BINARY NULL, 
  `mstatus` VARCHAR(5) BINARY NULL, 
  `ssn` VARCHAR(11) BINARY NULL, 
  `homephone` VARCHAR(12) BINARY NULL, 
  `race` VARCHAR(5) BINARY NULL, 
  `ethnic` VARCHAR(5) BINARY NULL, 
  `religion` VARCHAR(5) BINARY NULL, 
  `language` VARCHAR(5) BINARY NULL, 
 PRIMARY KEY (`facility`, `local_id`) 
) 



ENGINE = INNODB  
COMMENT = 'Patient Details Table' 
; 
SET FOREIGN_KEY_CHECKS = 1; 

 
The MySQL table creation script is provided as ui_pid_patient_create.sql in the 
companion archive, 02_PatientSvc_companion_archive.zip. 
 
The MySQL insert statements script, populating the ui_pi_patient table with 10 seed 
records, is provided as ui_pid_patient_insert_seed.sql in the companion archive, 
02_PatientSvc_companion_archive.zip. 
 
Execute the ui_pid_patient_insert_seed.sql script to add the seed data to the database 
table. 
 
There are six reference table create and populate scripts in the companion archive, 
02_PatientSvc_companion_archive.zip. These are ui_ethnicity_tab_all.sql, 
ui_gender_tab.sql, ui_language_tab_all.sql, ui_mstatus_tab_all.sql, ui_race_tab_all.sql 
and ui_religion_tab_all.sql. Execute these scripts, in any order, to create and populate 
reference tables. These scripts are in the companion archive, 
02_PatientSvc_companion_archive.zip. 
 
There is also a ui_pid_patient_view.sql view definition, which provides a view of the 
patient data with coded values as well as their translations. Execute this script to create 
the view. This script is provided in the companion archive, 
02_PatientSvc_companion_archive.zip. 
 
Now that we have the necessary database objects in the database we need to verify that 
the database is known to NetBeans. This will make it simpler for us to use the database in 
the project.  

Switch to the Services Tab, right-click Databases, expand Databases node and verify that 
a connection to the MySQL database has been created. If not, you probably did not 
complete the pre-requisite Facility Service walkthrough [2]. This walkthrough must be 
completed in order to complete this walkthrough and subsequent walkthroughs in the 
Patient Service series. 

 

If not connected, right-click the database URL and choose Connect … 

Once connected, expand the URL node and Tables node. Confirm that you have the 
following tables (Right-click the URL and choose Refresh if you don’t see what you 
expect): 

ui_ethnicity_tab 
ui_facility (this was created in the walkthrough in [2]) 
ui_gender_tab 



ui_language_tab 
ui_mstatus_tab 
ui_pid_patient 
ui_race_tab 
ui_religion_tab 

 

Right-click the ui_pid_patient table and choose View Data to confirm that we have the 10 
seed records we expect to have, having executed the populate script earlier. 

 

We do. 



 

The database connection is available and correctly configured for NetBeans. Now we 
need to confirm the presence of a connection pool to be used at runtime. This connection 
pool would have been created as part of the Facility Service walkthrough [2]. 

Switch to the Services tab, expand Servers node, right-click on the GlassFish V2 node 
and choose View Admin Console. 

 

Your default web browser will open with the login page. Log in (presumable as 
admin/adminadmin). Navigate through Resources -> JDBC -> Connection Pools. Verify 
that the cp_pblog_XA connection pool exists and is functional by clicking at the pool 
name and clicking on the Ping button to test connectivity.  



 

Click through to Resources -> JDBC -> JDBC Resources. Confirm that the JNDI 
reference, jdbc/cp_pblog_XA, to the connection pool cp_pblog_XA, exists. This, too, 
should have been created when working through [2]. 

 

Since we have new tables in the same database as the ui_facility table we can use the 
same connection pool and JNDI reference for the new tables. 

Implementing PatientSvc Web Service 

If you worked through [4], which is not a pre-requisite, you will have a Project Group, 
PatientSvcPG, containing 4 projects – HL7Feeder, HL7Feeder_CA, HL7Receiver and 
HL7Receiver_CA. I assume you have. If you have not, create a Project Group, 
PatientSvc. We will use it to group our patient-related projects together. 



 

We will create a BPEL process, which will be exposed as a Web Service using the 
SOAP/HTTP BC and which will orchestrate database access services using the Database 
BC. 

To complete this section we will: 

1. create XML Schema definition for input and output messages 
2. create a web service interface WSDL definition (SOAP/HTTP BC) 
3. create a Database BC WSDL for a service which will insert patient 

record into the ui_pid_patient table 
4. create a Database BC WSDL for a service that will select all 

information about a specific patient given facility and local_id, using 
the ui_pid_patient_view view 

5. implement two operations, each of which will orchestrate one of the 
two Database BC services 

6. create a composite application and deploy it 
 
Let’s create a new BPEL Module Project, PatientSvc_BM. Once done, a skeleton BPEL 
module, patientSvc_BM, will have been created. Rename it to bpPatientSvc_BM. You 
don’t really have to. I just don’t like names other people picked for stuff so I tend to 
rename things more to my liking. 

 

The service implementation will insert a patient record, if one does not exist, or update 
patient record if it exists, and, given a facility code and local_id, will return all details 
available for the specific patient. A web service with two operations will be implemented.  

The Upsert operation will accept a list of patient details to insert or update and will return 
a status code to indicate success or failure. 



The Details operation will accept a facility code and local_id and will return all patient 
details for the specific patient or return a HaveRow == false if no record for the specified 
id is available. 

Let’s create a New -> XML Schema, Facility, with target namespace 
“urn:Sun:Michael.Czapski:XSDs:/Patient ”. 

 

Add 4 elements at the root level: PatUpsertReq, PatUpsertRes, PatDetailsReq and 
PatDetailsRes. 

 



 

Under PatUpserReq add elements specified in the following table, taking care to set the 
datatype and MinOccurs attributes as indicated. 

Name Datatype MinOccurs 
FACILITY string 1 
LOCAL_ID string 1 
LAST_NAME string 1 
FIRST_NAME string 1 
MIDDLE_INITIAL string 0 
SUFFIX string 0 
TITLE string 0 
ADDR1 string 0 
CITY string 0 
STATE string 0 
POST_CODE string 0 
COUNTRY string 1 
DOB string 1 
SEX string 1 
MSTATUS string 0 
SSN string 0 
HOMEPHONE string 0 
RACE string 0 
ETHNIC string 0 
RELIGION string 0 
LANGUAGE string 0 

 



 

 

 



 

Under PatUpsertRes add a boolean element called STATUS. 

 

Under PatDetailsReq add two string elements named FACILITY and LOCAL_ID. 

 

Under PatDetailsRes add a Boolean and a set of string elements specified in the table 
blow, taking care to set the datatype and MinOccurs attributes as indicated. 

Name Datatype MinOccurs 
HaveRow boolean 1 
FACILITY string 0 
FACILITY_NAME string 0 
LOCAL_ID string 0 
LAST_NAME string 0 
FIRST_NAME string 0 
MIDDLE_INITIAL string 0 
SUFFIX string 0 
TITLE string 0 
ADDR1 string 0 
CITY string 0 
STATE string 0 
POST_CODE string 0 



COUNTRY string 0 
DOB string 0 
SEX string 0 
PATIENT_GENDER string 0 
MSTATUS string 0 
MARITAL_STATUS string 0 
SSN string 0 
HOMEPHONE string 0 
RACE string 0 
PATIENT_RACE string 0 
ETHNIC string 0 
PATIENT_ETHNICITY string 0 
RELIGION string 0 
PATIENT_RELIGION string 0 
LANGUAGE string 0 
PATIENT_LANGUAGE string 0 

 

The reason we make all field, except HaveRow, optional is because we may request 
details for a patient whose record does not exist. The HaveRow element, a Boolean, will 
be set to true or false to indicate where we have data for the patient. If we had non-
optional elements in the patient details structure we would have been unable to return the 
structure with no data in it and would have to resort to throwing a SOAP Fault in the 
event that patient record did not exist. It would have been a valid solution to the problem 
but I have chosen to do it with a Boolean flag rather then a SOAP Fault. 

 



The Patient XML Schema is ready. We can now use the request and response definitions 
in a WSDL that defined the service interface for the PatientSvc service. 

PatUpsertReq and PatUpserRes are messages that will be associated with the operation 
opUpsertPatient, which will return the Boolean true (success) or false (failure) upon 
completing an insert or an update operation on the patient table. 

PatDetailsReq and PatDetailsRes are messages that will be associated with the operation 
opGetPatientDetails, which will return all available details for a specific patient, using 
facility and local_id as components of the lookup key, or will set HaveRow to false if no 
row is available. 

Let’s now create a New -> WSDL Document, of WSDL Type Concrete, Binding: SOAP 
and Type Document/Literal, named PatientSvc, with target namespace of 
“urn:Sun:Michael.Czapski:WSDLs:/PatientSvc ”, which uses the schema 
elements defined in the Patient.xsd. 

 

Rename the operation to opUpsertPatient, rename the Input message to pPatUpsertReq 
and choose the PatUpsertReq element as the datatype. 



 

Rename output message to pPatUpsertRes and choose the PatUpsertRes as the datatype. 

 



Click Next and Finish. 

This gives us a WSDL interface definition for a service with a single operation, 
opUpsertPatient. We now need to add another operation, opGetPatientDetails, which uses 
PatDetailsReq and PatDetailsRes messages for input and output respectively. 

Let’s add two new messages, opPatDetailsRequest and opPatDetailsResponse. 

 

Let’s rename part1 nodes in both new messages to pPatDetailsReq and pPatDetailsRes 
respectively. 

 

Let’s now set the data types for these parts: PatDetailsReq and PatDetailsRes 
respectively. 

 



 

This gives us two new messages for the new operation. 

Let’s right-click the PatientSvcPortType node, choose Add and choose Operation. 

 

Rename operation to opGetPatientDetails and choose tns:opPatDetailsRequest for input 
message. 

 

Choose tns:opPatDetailsResponse for output message and click OK to complete the 
wizard. 



 

The port type now has two operations with their associated request and response 
messages. 

 

Right-click the PatientSvcBinding, choose Add and choose Binding Operation. 

 

New operation gets added. We must now configure it. 



 

Right-click opGetPatientDetails and choose Add -> SOAP Operation. 

 

Right-click in Input2 and Output2 in turn and choose Add -> SOAP Body 

 

 

This completes the WSDL definition. We have a WSDL with two operations. Switch to 
Source mode and Validate and Check XML. 

 

Now we need to prepare interfaces definitions for Database-related services. 



Each of the two service operations will execute different SQL statements to get different 
data from the database.  

With GlassFish ESB and the Database Binding Components there are a couple of ways in 
which a database service can be configured. We will use both.  

For the first operation, opUpsertPatinet, we will create a Database Table BC 
configuration to get access to SQL insert, SQL select and SQL update statements. 

For the second operation, opGetPatientDetails, we will create a Database SQL Statement 
BC configuration to execute na prepared statement: 

select * from ui_pid_patient_view where facility = ? and local_id = ?  

For the Upsert Database BC configuration we will create the New -> WSDL Document. 

 

We will name this WSDL document PatUpsert. It will be a Concrete WSDL, using 
DATABASE binding of type Table. 

 

We will specify the database URL, created earlier in NetBeans, pointing to the pblog 
database. 



 

From the list of available tables we will choose the ui_pid_patient table. 

 

We will accept default for table properties. 

 

To provide for the runtime connection to the database we will specify the JNDI reference 
pointing to the connection pool which we created earlier. 



 

This produces a Database BC configuration WSDL. For this project we are only 
interested in the Find, Insert and Update operations. The Insert operation is configured in 
the WSDL with the SQL insert statement. 

 

The Update operation is configured in the WSDL with the SQL update statement. 

 

We must modify the update SQL statement by providing a SQL WHERE clause which 
will select the correct record to update. If we fail to add the SQL WHERE clause the 
update statement will attempt to update all records in the table with the same data. If there 
happens to be a unique primary key on the table, as is the case in the table with which we 



are dealing, an attempt to execute the update will result in a duplicate key exception when 
the JDBC driver tries to update the second row with the same key values. This may or 
may not be what you expect and need.  Append “ where facility = ? and local_id = ?” to 
this statement. The complete statement will look like this: 

 

Now that we modified the statement, which adds two more parameters to the list, we need 
to also modify the parameter list to specify the two additional parameters, with the correct 
names in the correct places. 

 

We added “facility = ? and local_id = ?” to the SQL statement so we needed to add 
facility and local_id to the list of parameters. 

Now the update statement will attempt to update a specific row, rather then all rows it 
would attempt to update if we did not add the SQL WHERE clause. 

We will also use the find operation to perform a select statement looking to a patient 
record by facility and local_id. The SQL statement generated by the wizard for the find 
operation looks like this: 



 

This statement will “find” all rows in the table. Clearly this is not what is required. As 
with the Update statement we need to add a SQL WHERE clause to select the row “where 
facility = ? and local_id = ?”. 

 

Also, as with the Update statement, we must add the corresponding parameters to the 
paramOrder list, witch is currently empty. 

 



Now the Database BC WSDL, which we will use to implement the Upsert operation, is 
ready to use. 

The next Database BC WSDL will be for the Details operation. We will select a specific 
row using the ui_pid_patient_view SQL View. 

Let’s create a New -> Empty File, named PatViewSelect.sql. 

 

 

Choose MySQL connection associated with the pblog database. 

 

Enter the SQL statement and save. 

 

Right-click the name of the SQL file, choose Properties, click the ellipsis button to the far 
right of the All Files property and copy the location of the SQL file. 



 

Create a New -> WSDL Document. Name the WSDL PatViewSelect. Choose Concrete, 
DATABASE biding of type SQL File, then click Next. 

 

Choose the connection associated with the pblog MySQL database and click Next. 

 

Browse to the location of the SQL File, pasting the location you copied earlier, and click 
Next. 



 

Click the Discover Parameters button and rename param1 and param2 to pFacility and 
pLocalID respectively. 

 

Click the Discover Resultset button and click Next. 

 

Enter “jdbc/cp_pblog_XA” into the JNDI name box and click Finish. 



 

Database BC WSDLs are now ready. The service interface, PatientSvc WSDL is also 
ready. We can now construct the business process to orchestrate the two Database BC 
services. 

Let’s drag the PatientSvc WSDL onto the left-hand swim line of the bpPatientSvc_BM 
process and release over the target marker. 

 

Rename the partner link to PatientRR. 

 

Drag the PatUpsert WSDL onto the target marker in the right-hand swim line and rename 
the partner link to UpsertDB. 



 

 

Drag the PatViewSelect WSDL onto the target marker in the right-hand swim line, below 
the UpsertDB partner link and rename it to SelectDB. 

 

 

This gives us all the partner links we will need. 



The PatientRR partner link represents the two-operation WSDL interface. We need to 
implement both the Upsert and the Select operations.  

The Upsert operation will have the following logic: 

1. use facility and local_id values from the request to select a record  
2. if the record exists update the corresponding record in the database table 
3. if the record does not exist inert a new record into the database table 

We are performing a select on the database table to determine whether the record already 
exists. We could have attempted to perform an update first but we would have no way of 
knowing whether the update succeeded. An attempt to update a non-existent record does 
not generate an exception and the database BC, as it stands at this point, does not tell us 
whether any records were affected by the update operation. Thus we would have no way 
of knowing that the record was not updated, therefore perhaps it did not exist, therefore 
perhaps we should try to inert a new record instead. 

Alternative logic could be to first attempt to insert the record. If the record exists this 
would cause an exception which we would handle in a fault handler by performing an 
update.  

The Select operation will have the following logic: 

1. select by facility and local_id 
2. if select returns 0 rows set HaveRow to false and return the response 
3. if select return 1 row set HaveRow to true and populate and return the response 

Open the bpPatientSvc_BM process. 

In the process Properties set the “Ignore Missing From Data” property to Yes. This makes 
for easier mapping. If we don’t set this property to Yes, or set it to No, whenever data 
used for mapping is missing in the source structure, an exception will be thrown at 
runtime and the process will be aborted. With this property set to Yes mapping with the 
missing source data will be ignored, allowing the process to continue with the next 
mapping rule. 

  

Add the Pick activity to the process scope. The Pick activity will allow us to implement 
multiple operations as separate stream of activities, triggered by different messages and 
returning different responses. 



 

Open the Properties of the Pick activity and check the “Create Instance” property. 

 

Add the Reply activity to the process. 

 

Connect the OnMessage and the Reply activities to the Upsert operation. 



 

Edit the OnMessage activity and add an Input Variable, vUpsertReq. 

 

Edit the Reply1 activity and add a Normal Response Output Variable, vUpsertRes. 

 



Add Assign and Invoke activities between the OnMessage and Reply activities. Here we 
will configure and invoke the find operation which will determine if a record with the 
facility and local_id in the request already exists. 

 

Connect the Invoke1 activity to the find operation of the UpsertDB partner, edit the 
Invoke1 activity and create two variables, vFinsReq and vFindRes. 

 

Double-click the Assign1 activity and map vUpsertReq->pPatUpsertReq->FACILITY 
and vUpsertReq->pPatUpsertReq->LOCAL_ID to vFindReq->part->ui_pid_patient_Reco
rd->facility and vUpsertReq->pPatUpsertReq->LOCAL_ID to vFindReq->part->ui_pid_
patient_Record->local_id respectively. 



 

Switch back to Design view and add an If construct to the canvas following the Invoke1 
activity. 

 

Double-click the “top” If diamond to switch to the Mapper and configure the conditional 
expression. 

 

The conditional expression, which we will be configuring, attempts to determine whether 
the facility and local_id in the Upsert request are the same as these in the row returned by 
the select statement. If the select did not return a row the conditional expression will 
evaluate to false. 



Select the “Boolean Condition” node, pull down the “Boolean” functioid dropdown and 
drag the “Logical And” functoid onto the swim line. 

 

Drag two Equals functoids from the Operator functoid dropdown onto the swim line and 
connect. 

 

Connect the vUpsertReq->…->FACILITY and vUpsertReq->…->LOCAL_ID to the top 
connectors of the equals operators. 

 



Connect vFindRes->…->facility and vFindRes->…->local_id to the bottom connectors of 
the corresponding equals operators. 

 

The conditional expression is now complete. Switch to the Design view. 

Add Assign, Invoke and Assign activities to the “true” branch and Assign, Invo0ke and 
Assign to the “false” branch. 

 



In each case we will configure the request message, invoke the Update operation for the 
“true” branch or insert operation for the “false” branch, then configure the response. 

Connect Invoke2 activity to the Update operation of the UpsertDB partner and an Input 
Variable, vUpdateReq. The Update operation produces no output so there is no need to 
create a variable for it.  

 

Double-click Assign2 to switch to the Mapper and configure the input to the Update 
operation using values in the Upsert request. 

 



Switch back to Design view, double-click the Assign3 activity and configure the response 
foe the Upsert operation. 

Because the Update operation does not give us any feedback we assume it succeeded, so 
we set the vUpsertRes->…->STATUS to Boolean -> Logical True. 

 

This completes configuration of the “true” branch. Let’s now configure the “false” 
branch. Let’s switch back to Design mode, connect the Invoke3 to the Insert operation of 
the UpsertDB partner and add two variables, vInsertreq and vInsertRes. 

 

Let’s double-click the Assign4 activity, just above the Invoke3 activity, and configure the 
input message to the Insert operation using values form the Upsert request. This is almost 
the same mapping as that for the Update operation. 

You may recall that there are a number of elements in the Upsert request which are 
optional, highlighted in the picture below. 



 

You may also recall that we set the IgnoreMissingFromData process property to Yes.  

If the optional data is missing the Database BC will inert empty strings for these columns. 
We don’t want that. What we want is to have NULLs inserted. The Database BC wizard-
generated structure has an isNull attribute for every available column. 

 

We will use this attribute to indicate to the Database BC that a specific column is to be set 
to NULL if there is no data to be inserted. 

Let’s begin by assigning Boolean -> Logical True to isNull attribute of all database 
columns which correspond to the optional elements in the request message. 



 

Now we map the request values to the input message as we did for the Update service 
earlier. 



 

Switch to the Design view, double-click the Assign5 activity, just below the Invoke3 
activity, and configure mapping for the Upsert response. vInsertRes returns an int giving 
the number of rows inserted. For a successful insert this will be 1. We take advantage of 
that to set the value of the vUpsertRes->…->STATUS, a Boolean, to true if the number 
of inserted rows is greater then 0 and to false otherwise. 



 

The implementation of the Upsert operation is now complete. 

 



Let’s now configure the opGetPatientDetails operation.  

Switch to the Design mode, click the Pick icon and click the Add OnMessage button. 

 

Add a Reply activity after the new OnMessage activity. 

 

Connect the new OnMessage activity and Reply2 activity to the opGetPatientDetails 
operation of the PatientRR partner. 

 

Edit the new Message and Reply2 activities and add new variables vSelectReq to the 
Message and vSelectRes to the Reply2. 



 

 

Add Assign and Invoke activities between the Message and Reply2 activities. 

 



Connect Invoke4 to the operation of the SelectDB partner then add two variables, 
vSelDBReq and vSelDBRes. 

 

Double-click Assign6, just above the Invoke4, to switch to Mapper and configure the 
input message for the SelectDB partner’s operation. 

It may get difficult to keep track of which variables belong to what object so it is very 
important to develop and consistently use a variable and partner link naming convention. 
I have my own that works for me. I am using it in all projects I develop. Feel free to 
develop your own. 

In my case the vSelectReq variable belongs to the PatientRR partner’s 
opGetPatientDetails operation. I should perhaps have named it vDetailsReq, and its 
response brother vDetailsRes, but I did not. vSelectReq and vSelectRes are variables 
associated with the PatientRR. The SelectDB partner has the vSelDBReq and vSelDBRes 
variables associated with it. We map the value provided on the inbound request to the 
nodes in the DB select operation. 

 

Switch to the Design view. 



You may recall from an earlier discussion that the select operation will return zero or 
more rows. In this case we expect either no rows or a single row. We used the If 
conditional to determine if we have a row by comparing the facility and local_id values in 
the request with the data returned by the select operation, if any. If no rows were found 
the comparison will return false, telling us that no rows were selected. Let’s reproduce 
this construct here. 

Add the If construct to the canvas immediately following the Invoke4 activity. 

 

Double-click the “top” diamond of the conditional to switch to the Mapper and configure 
the conditional expression. 

 

 



Let’s now add an Assign activity to each branch of the If conditional. 

 

Configure Assign7 activity to map the response of the Select operation to the response of 
the GetPatientDetails operation, making sure to map Boolean -> Logical True to the 
HaveRow node. 

 



Switch to Design mode, double-click the Assign8 activity, on the “false” branch, and 
configure response by setting the HaveRow node to Boolean –> Logical False, leaving all 
other nodes unmapped. 

 

Switch to the Design view, right-click the name of the project and choose Build. 

Now that the process is ready we need a composite application to create and deploy the 
runtime object. 

 



Create a New Project -> SOA -> Composite Application. Name it PatientSvc_CA, then 
drag the project PatientSvc_BM onto the CASA editor’s canvas. 

 

Build. 

 

Deploy. 

 

With the project deployed we are now in a position to test it. 

Testing with Soap UI 

The ui_pid_patient table has 10 rows of seed data, added when we created database 
objects in the initial sections of this walkthrough. 



 

Our PatientSvc service is a Web Service. We can exercise it using either the built-in 
testing facilities or the Soap UI NetBeans plugin, or both. 

Let’s work out what the Service URL and Service WSDL URL will be. Expand the 
PatientSvc_BM project, locate the PatientSvc WSDL, open it in the editor, expand 
Services node through to soap:address, right-click soap:address and chose Properties. 

 

Copy the Location property.  

 

For me it will be: 

http://localhost:${HttpDefaultPort}/PatientSvcServi ce/PatientSvcPort 



Note the ${HttpDefaultPort} notation. The HttpDefaultPort variable will be replaced at 
deployment time with the actual port number. This port number is configured in the sun-
http-binding. 

 

For me it is 29080 so my Web Service Endpoint URL will be: 

http://localhost:29080/PatientSvcService/PatientSvc Port 

The WSDL URL will be: 

http://localhost:29080/PatientSvcService/PatientSvc Port?WSDL 

Let’s create a web service testing project, PatientSvcWSTP. New Project -> Java EE -> 
Web Service testing Project. 

 

 Name the project PatientSvcWSTP and provide the WSDL URL we worked out before. 



 

Expand the PatientSvcWSTP all the way to opGetPatientDetails, right click on 
opGetPatientDetails and choose New Request. 

 

Name the new request “Request ARMC / 0101018”. 

 

Replace FACILITY and LOCAL_ID values with ARMC and 0101018 respectively and 
submit the request. 

 



If all went well you will get a SOAP response with details of this patient. 

 

Let’s now add a request to the opUpsertPatient operation, naming it “Request STC / 
100000”. 

Let’s populate it with data to resemble this: 

<soapenv:Envelope  
 xmlns:soapenv="http://schemas.xmlsoap.org/soap/env elope/"  
 xmlns:pat="urn:Sun:Michael.Czapski:XSDs:/Patient">  
   <soapenv:Header/> 
   <soapenv:Body> 
      <pat:PatUpsertReq> 
         <pat:FACILITY>STC</pat:FACILITY> 
         <pat:LOCAL_ID>100000</pat:LOCAL_ID> 
         <pat:LAST_NAME>CAESAR</pat:LAST_NAME> 
         <pat:FIRST_NAME>JULIUS</pat:FIRST_NAME> 
         <pat:SUFFIX>EMP</pat:SUFFIX> 
         <pat:ADDR1>1 VIA APPIA</pat:ADDR1> 
         <pat:CITY>ROME</pat:CITY> 
         <pat:COUNTRY>ROME</pat:COUNTRY> 
         <pat:DOB>  -1000713</pat:DOB> 
         <pat:SEX>M</pat:SEX> 
      </pat:PatUpsertReq> 
   </soapenv:Body> 



</soapenv:Envelope> 
 

Let’s submit the request, observe the response and inspect the database. 

 

The response contains the Boolean true, maning the insert operation executed 
successfully. The database shows: 

 

Note the outcome of setting isNull to true for optional data combined with “Ignore 
Missing From Data” - insertion of null values into columns whose data was missing. 

Let’s modify the request, changing ADDR1 to “2 VIA APPIA”, submit the request, look 
at the response and inspect the database table. 

As before, the response is true. The database table has been updated. 

 

We demonstrated that the service functions as expected. 

Summary 

In this document we walked through the process of creating a Patient service, exposed as 
a web service, implementing patient table upsert and return patient details operations. We 
created and deployed a project, PatientSvc, which orchestrated Database BC services to 
interact with the MySQL-based up_pid_ptient table containing patient data. We explored 
the use of select, insert and update Database BC services from BPEL as well as 
implementation of multi-operation web service and the use of If conditional in BPEL. 

There is a companion archive at http://mediacast.sun.com/users/Michael.Czapski-
Sun/media/02_PatientSvc_companion_archive.zip/details. This archive, called 
02_PatientSvc_companion_archive.zip, contains MySQL SQL scripts used to create 
MySQL objects used to implement the service and the projects discussed in this 
document in an archive called PatientSvcPG_v1.1.zip. The project archive contains all the 
project developed in this walkthrough and in the related walkthrough [4]. 
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